
 

 

 

 

 

 

COLOR projects 6 professional 

 

 

User manual 

 

 

  



COLOR projects 6 professional – User manual 

 

2 

Contents 

1. Activation ......................................................................................... 4 

2. What´s New? ................................................................................... 5 

3. Photos Done Quickly ....................................................................... 8 

4. Configuring the User-Interface ......................................................... 9 

5. Importing Image Material ............................................................... 10 

6. Menu Bar ....................................................................................... 11 

6.1 File ............................................................................................ 11 

6.2 Edit ........................................................................................... 13 

6.3 View .......................................................................................... 13 

6.4 Extras ....................................................................................... 15 

6.5 Add-ons .................................................................................... 23 

6.6 Information ................................................................................ 24 

7. Optional: Image Preparation .......................................................... 25 

8. Post-Processing: Presets ............................................................... 28 

9. Post-Processing: Finalisation ......................................................... 40 

10. Local Adjustments/Selective Drawing .......................................... 48 

11. Composing Mode ........................................................................ 59 

12. Texture Mode .............................................................................. 62 

13. Removal of Scratch and Sensor Errors ........................................ 67 

14. Post-Processing: Expert Mode .................................................... 70 

15. Workflow ...................................................................................... 83 

16. Selecting and Saving Sections of Images .................................... 86 

17. RAW-Processing ......................................................................... 88 



COLOR projects 6 professional – User manual 

 

3 

18. Batch Processing ......................................................................... 95 

19. Via GPS coordinates directly to Open-StreetMaps ...................... 98 

20. Plug-in Installation ........................................................................ 99 

21. Keyboard Shortcuts ................................................................... 110 

22. Integrated List of supported RAW Formats ................................ 115 

 

  



COLOR projects 6 professional – User manual 

 

4 

1. Activation 

 

Upon starting COLOR projects 6 professional for the first time, you will be 

prompted to activate the program. Proceed as follows: 

Install COLOR projects 6 professional as described in the installation instruc-

tions.    

Enter your serial number. For the box version, this can be found on the ac-

companying booklet. If you have chosen to download the program, you will 

have received the serial number by email directly following your purchase. 

 

Finally, click on the “Activate” button. The software has now been suc-

cessfully activated! 

Note: COLOR projects 6 professional can be installed on up to two comput-

ers using the same serial number.  

A second serial number is not necessary. When installing the program on a 

second device, simply enter the serial number again and press “Activate”.    
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2. What´s New? 

 

COLOR projects 6 professional offers a variety of new features. Here is an 

overview of some of the most important developments: 

 

 With 48 new presets, COLOR projects 6 professional now has a total 
of 208 presets. Three new preset categories have also been added: 
- The category „photo-style“ with the styles “vintage”, “halftone” 

and “poster” 
- The category „light FX“ with the styles „lightframe“ and „light 

incidence“ 
- The category „kirilian“ with a simulation of the "aura-

photography" 
 

 New effect category for intelligent and automatic masking of post-
processing effects: Smart mask filter with 13 different masks (see 
chapter 14). 
 

 23 new layer processing methods: 
- Add, add limited, add difference, deep shadows, bright lights. 
- 9 HSL methods: HSL stands for Hue, Saturation and Lightness. 
- 9 HSV Methoden: HSV stands vor Hue, Saturation and Value. 

You can use the layer processing methods to determine how the effect 
layer is calculated (see chapter 14). 
 
 Enhancements in Image Cropping: New are the center mode and a 

display of the crop size in pixels. 
 

 The new SCA method offers "supersampling contour protection" in 
the intelligent color space (see chapter 9). 

 
 New in Selective Drawing: 

- New effects: Correct red eye, beauty 
- All layer processing methods in composing 
- New module: Textures and materials: Textures can be trans-

ferred to the image with the selective brush in 16 layers from 64 
supplied textures (see chapter 12). 
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 New in the RAW Module 
- Graphic configuration of horizon correction 
- Create own profiles 
- Adjustable display options 
- 7 new effects: 

 Normalise Lights/Shadows  

 Colour Denoising 

 Exposure 

 Normalise Shadows 

 Normalise Lights 

 RGB-Exposure 

 Colour gradient 
 
 

 1:1 Comparison Window with 4 comparison modes: 
- Divided left/right, divided right/left 
- Side by side left/right, side by side right/left 
- Zoom function 

 
 Extension of the external programs: Up to 12 external programs are 

now available. In addition, the names of the external programs are 
configurable. 
 

 COLOR projects 6 professional  has now 22 new Post-Processing ef-
fects (total 181):  
 

 Dilate  Dithering Floyd-Steinberg 

 Erode  Offset 

 Exposure  Normalise 

 Chromatic correction (CA)  Normalise RGB 

 Horizontal soft focus  Vertical soft focus 

 Kirilian glow  Kirilian soft focus 

 Light bokeh                                                                      Exposure errors 

 Fireworks  Light effects 

 Light frame  Light spot 

 Bubbles  Soap bubbles 

 Under Water  Wave distortion 
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 The scaling function when loading images now ranges from 10 to 
900%. The calculation of the new image size is calculated on the ba-
sis of the image area. For example, small scaling is useful if you want 
to upload your image directly after editing on the internet.  

 
 Print final image 
 
 Clipboard 

 
 New function: Copy result image to original 

 
 New in image preparation: 

- Colour normalisation of input images 
- Adjustment to camera display 

 
 Note Function in the Undo-Timeline (see chapter 15) 
 
 Create Exposure Bracketing: New mode „according to EV value“ 
 
 New optimisation methods in the drop-down menu of the optimisa-

tion assistant: naturally cool , naturally warm, colourful and Low key 
colourful 
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3. Photos Done Quickly 

 

Four clicks in COLOR projects 6 professional and you’re done: 

 

1. Load image  

2. Post-Processing: Preset selection 

3. Optimisation Assistant: Fine adjustment 

4. Crop image, save and you are done!  

 

Simply drag and drop your images onto the start screen. 

 

Just like that and you’re finished editing in no time – or go the creative route 

with individual image adjustments, the RAW Module or selective painting: 

COLOR projects 6 professional offers the necessary tools for both. 

  



COLOR projects 6 professional – User manual 

 

9 

4. Configuring the User-Interface 

 

Adjustable Font Size for Menus and Headings  

Provided in the program’s main menu under View -> Font Size, this option lets 

you customize the font size of menu texts as well as in-program headings.  

 

 

 

Font size settings can be adjusted directly at program runtime.  

Users working on 4K monitors have the possibility to improve menu legibility 

by increasing the font size. 
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5. Importing Image Material 

 

To load an image, simply drag and drop the images onto the start screen. 

Alternatively, you can also use the dropdown file menu.    
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6. Menu Bar 

 

6.1 File 

 

File → Start  

When you are finished editing 

an image or would like to close 

your current image, clicking on 

Start (or Ctrl + N) will close the 

currently displayed image.  

File  Load Image…   

In order to open an image, click 

on Load Image (oder Ctrl + Shift 

+ O), to search for the sequence 

you would like to edit. 

 

File → Image Data Browser…  

Select your image folder from within the “Source-Folder”. COLOR projects 6 

professional immediately begins its calculation process and shows a preview 

image. From here you can then upload your preferred image. 

 

File → History Viewer …  

Clicking here will provide you with an overview of your separate projects and 

allow you to choose between them. Double-click on the images or projects 

that you want to open.  

File → Save Final Image …  

If you are satisfied with your editing results and would like to save your image, 

click on Save Final Image (or Ctrl + S). 
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File → Open Final Image in External Program… 

If you would like to continue editing your current image in another program, 

you don’t even need to leave COLOR projects 6 professional. Therefore, simp-

ly click on Open Final Image in External Program. 

 

File → Create Exposure Bracketing …  

Click here to create an exposure bracketing from your image. You can choose 

between three, five, seven, nine or eleven exposures. Furthermore four op-

tions for the latitude and two different processes are available. The process 

“Exposure value” is new. 

 

File → Print Final Image …   

Click here to print your final image. The image is automatically and correctly 

scaled to the print medium. 

 

File → Copy Final Image into Clipboard …   

The final image is posted to the clipboard. You can then seamlessly insert it 

into other programs. 

 

File → Projects …  

If you’ve already begun a project in COLOR projects 6 professional and would 

like to continue editing, open the file by clicking on Projects. 

 

File → Exit  

Click on Exit (or Ctrl + F4) to close COLOR projects 6 professional. 

 

 



COLOR projects 6 professional – User manual 

 

13 

6.2 Edit 

Edit → RAW Processing   

Whenever you want to easily edit a photo, 

simply click on RAW processing to do things like alter colours in the photo or 

distort the image (please see 17. RAW Processing). 

 

Edit → Post-Processing   

Once you have edited or removed noise from an image, you find yourself in 

the Post-Processing Mode.    

 

6.3 View 

 

View → Information Window  

This window displays all image information regarding the preset settings. 
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View → EXIF Information Window  

This window displays (if available) all image file EXIF information such as loca-

tion, camera type, exposure duration and capture time. 

 

View → Histogram  

The histogram shows you concisely the information of the brightness control 

in the photo, so you can quickly recognize whether your photo is under- or 

overexposed. 

View → Full Screen View On/Off  

If you ever feel distracted by the task bar, you can toggle between a normal 

and a full screen view by clicking on Full Screen View On/Off. 

 

View → Interface-Style... (dark grey)  

Clicking on Interface Style... will allow you to alter the colour scheme for COL-

OR projects 6 professional. The colour scheme you have currently selected 

will appear in brackets. 

 

View → Font Size …  

Change the font size levels for menus and headlines between small, medium 

and large. 

 

View → Frame Colour: Grey Cart → automatic  

If you click on Frame Colour: Grey Cart  automatic, the program will set the 

average colour from your image as the frame colour. 
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View →  Restore Window defaults  

Returns the current window to its original size. 

 

6.4 Extras  

 

Extras → Batch Processing   

Batch processing in COLOR 

projects 6 professional enables 

the automatic processing of 

multiple image sequences.  

 

Extras → Preparing Image…  

Here you can begin to prepare 

your images prior to post-

processing (see chapter 7. Op-

tional: Image Preparation). 

Extras → Benchmark  

If you would like to know how quickly your PC can remove noise from your 

images, Benchmark is the function to choose. The programs will render five 

different images in real-time and provides you with an evaluation on a five-star 

scale. 

Extras → Settings… (Ctrl + P)  

Here you will find the various configuration options adaptable to your unique 

preferences offered in COLOR projects 6 professional. 
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Program: Location 

Here you can determine in which folder projects, exposure bracketing/ photo 

series, final images and default settings will be saved. 

 

Program: Language 

Here you can change COLOR projects 6 professional program language to 

either German, English or French. 

 

Program: Accelerate GPU  

Here you can choose to either activate or deactivate graphic card computing 

speed acceleration. 
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Program: Tooltips 

Hovering your cursor long enough over specific tools or menu options will 

prompt the display of a short text offering an explanation of the function or 

tool. This is called Tooltip. Tooltips can also be deactivated here if preferred. 

 

Program: Progress Bar 

While the processing of effects in COLOR projects 6 professional, the progress 

will be displayed with the help of a progress bar. Here you can decide when 

and whether to display the progress bar. 

 

Program: Projects 

When selecting the compression level, you are deciding how much storage 

space will be allocated for each of your projects. In other words, you are decid-

ing on how quickly the storage is performed. A lower level saves the projects 

faster, a higher level reduces the amount of storage space available on your 

hard disc. 

 

Program: Undo 

With the option “save undo steps in projects”, you can save all undo steps 

within the project file. The undo-steps will then be completely reproduced 

when the file is opened. This creates a significantly larger project file. Set the 

maximum number of undo steps (1, 5, 10, 20 or 50). If you do not wish to set a 

maximum, select “unlimited”. The minimum free disk space specifies the 

amount of free space on your hard drive that will not be taken up by saving 

undo steps. This ensures the proper functioning of your operating software. By 

default, this is set to 10% of your hard disk capacity but can be increased or 

decreased accordingly. 

 

Program: Preview Mode 

In preview mode you can choose between the modes "optimal" and "quick". If 

the "optimal" mode is activated, the preview size is adjusted to the available 
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space in the image area. You get maximum quality in preview mode. If the 

"quick" mode is activated, the preview size is always adjusted to half the avail-

able space in the image area. You get optimal speed in preview mode.  

You can also set the size of the preview exposure bracket in megapixels (unless 

you have selected the automatic 1:1 or 2:1 pixel mode). Choose a high value if 

you have a very fast working system.  

 

 

External Programs 

Here you can choose in which format COLOR projects 6 professional will ex-

port images to external programs. You can specify which programs should be 

used for external image editing. 

Navigate to the file in which the function is installed and select it. 
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Calculation 

Quality 

The calculation quality sets the size of the area around a pixel to which a given 

algorithm is applied during calculations. The word superquadrics describes 

geometrical forms (in this case, a 2D surface area) with a special outline. This 

form is then mapped to the area to which a given algorithm is applied. This 

means that around each pixel, only the pixels which fall within the superquad-

ric shape are included in the calculation (displayed as a white area). To select 

the maximum calculation quality for your images, move the slide to the far 

right. Remember that this will noticeably increase processing time. 

 

Luminance conversion 

This allows you to determine which colour portion is weighted how strongly 

when converting to a brightness (luminance). You can select the three "usual" 

standards in the preferences. Alternatively, you can also determine the colour 
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weights directly using the sliders. For these sliders, the sum of the three colour 

components must always be 100%. 

The display of the two colour circles helps you to estimate how your set value 

affects different colours. The left circle represents the original colours and the 

right circle the brightness converted with your values. 

 

 

Save formats 

 

 

Jpg 

Jpg or Jpeg is the most common and popular format for most cameras and 

image editing programs. Here you can control the quality as well as optimally 

compress the image. Compressed images with high quality look better but do 

require more storage space. 
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Tif 

Here you can choose between different compression methods for your Tif 

files. 

Png 

You can select one of four compression levels for 16-bit-Png images.  

 

Automatic 

 

 

Automatic: Post Processing 

Post-processing automatically sets the corn engine back to its original settings 

with every newly started project. To use a fixed corn value in batch processing, 

set it in the program and then deactivate this option. 
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Automatic: Security Questions and Additional Information 

Here you can choose whether or not to display security questions or additional 

information. 

 

Automatic: Automatic Undo Points 

Creates an automatic Undo-Point before RAW development, sensor correction 

or selective drawing. This creates a definitive starting point after uploading the 

image. 

 

Automatic: Image Preparation 

Displays the image preparation window when images are exported over a 

Plug-in. 

 

Automatic: Image Saving 

Activate the option “always save in highest resolution” and the processed 

image will automatically be saved in full resolution, even if the preview mode 

is active. Activate the option “show crop window when saving” and the crop 

window will automatically be displayed before image saving. 

 

Automatic: Point of Interest 

Automatically activates the full resolution of the image during activation. 

 

Automatic: Batch processing/ image data browser 

Here you can activate the automatic loading with the last used directory when 

opening the image data browser. You also activate the automatic inclusion of 

subdirectories in the image data browser and batch processing.  

You can also prevent files from being overwritten by automatically adding the 

original file extension (e.g. jpg, tif,...) for the file name created in batch pro-

cessing. 
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Extras → Reset  

This returns the current user interface to its original size. 

Extras → Create Restore Point (Shift + Z)  

If you would like to save your image in its current state and continue editing 

without initiating a file-save, simply select the option Create Restore Point or 

(Shift + Z). This allows you to return to the last saved state of your image at 

any time. 

Extras → Timeline (Ctrl + T)  

Click on the Timeline or (Ctrl + T) to display all saved Undo-Points. 

 

6.5 Add-ons 

 

Add-ons → Import Add-on  

With the help of Add-ons, you can now 

not only import Presets into COLOR pro-

jects 6 professional but also integrate 

new post-processing modules that may be 

necessary for a new preset look. 

 

Add-ons → Remove Add-on  

This button lets you remove add-ons. 

 

Add-ons → Add-on Information  

Here you are provided with a display of all information regarding currently 

active Add-ons. 
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6.6 Information 

 

Information → BLACK WHITE projects – Homepage  

Click here to navigate to the COLOR projects 6 professional homepage. 

 

Information → Show Shortcuts…  

Here you will find all keyboard shortcuts available in COLOR projects 6 profes-

sional. 

 

Information → Supported RAW Formats…  

A list of all cameras whose RAW Files are able to be opened in COLOR projects 

6 professional. 

 

Information → Check For Updates …  

This checks online if a new version of the software is available. 

 

Information → About BLACK WHITE projects… (Shift + F1)  

Information about the current version, 3rd-Party Software and Credits from 

BLACK&WHITE projects. 



COLOR projects 6 professional – User manual 

 

25 

7. Optional: Image Preparation 

 

Click on Extras/ image preparation…. Here you can precisely configure the 

program’s settings or leave 

the default settings and sup-

press the window when load-

ing the images.  

For the first steps, please use 

the standard settings. These 

default settings can be re-

stored with the arrow at the 

bottom left. So nothing can be 

irretrievably adjusted.    

 

a. Scaling: Upon up-

loading a bracketed 

series, images can 

be scaled anywhere 

from 25% to 400% 

using any one of the 

6 available scaling 

processes. For 

these, the following 

applies: The lower 

they are in the list, 

the better the quali-

ty and the longer 

the calculation time. 
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b. Colour space conversion: 

Advanced users can choose a 

colour space here - for all 

other users, it is recom-

mended to not make any ad-

justments, to avoid incorrect 

colour rendering. Later COL-

OR projects 6 professional 

offers several new colour 

spaces (D65). The standard 

illuminant D65 is repre-

sentative for a phase of nat-

ural daylight with the colour 

temperature of 6500° Kelvin.  

 

c. White balance corrects colour casts that occur with shots taken, for 

example, in a warmly lit room. To start, leave this setting unchanged.    

 
d. The colour temperature can be adjusted from 1000K to 16500K – a 

powerful tool to conjure up warm or cool picture moods.  

 
e. Optimisations: The Colour Normalisation automatically removes 

color casts already present in the RAW file. This ensures that shad-

ows within your image remain dark and lights stay bright.  The RAW 

to Camera Display Alignment function determines automatic align-

ment when a RAW image is loaded. This converts the RAW image 

during the loading process so that it comes as close as possible to 

the preview of the camera and the file preview. Automatic Brilliance 

Optimisation function can be activated for RAW file uploads in the 

RAW options section. Camera RAW formats often do not make use 

of all potential tone values. Automatic Brilliance Optimisation com-

pensates for this by enhancing tonal values, resulting in the creation 

of a more comprehensive histogram for each RAW image. If the 
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checkbox beside Automatic Rotation of Images is filled, images are 

corrected according to the orientation present in their Exif data. 

 
f. Use the reverse arrow to reset all changes back to the original value. 

 

 

 
Check the option „Always show this window“ and the Image Preparation 

window will automatically open upon starting the program. 

 

 

Use the arrow   to leave the image preparation and switch to post-

processing mode. 

  



COLOR projects 6 professional – User manual 

 

28 

8. Post-Processing: Presets  

 

After loading the images, the program 

takes us directly into post-processing 

mode. Here we select the appropriate 

preset for the photo and optionally edit 

the results with filters and effects. 

Left side of the post-processing screen: 

The presets show the breakdown of the 

live preview in categories – „All“, „Natu-

ral“, „Landscape“, „Portrait“, „Toning“, 

„Light FX“, „Custom“, „Surreal“, „Archi-

tecture“, „Artistic“, „FX“, „Photo-style“ 

and “Kirilian with the quantity of presets 

in the appropriate category . The new 

presets in this verison are: „Light FX“, 

„Photo-style“ and “Kirilian 

To begin, the preset „Naturally High 

Quality“ is selected. By clicking on the 

preview image, the effects are calculat-

ed in real time and displayed in the 

middle of the screen. 

Discover the wide variety of different 

looks by clicking on the 208 different 

presets. You will be amazed by the 

intriguing styles in the artistic section!   
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Image with „Natural Vivid colours“ preset. 

Image after applying the  „Light FX Light frame 4 “ preset. 
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All 208 COLOR projects 6 professional presets at a single glance. The bar “de-

fault settings” can be easily detached and adjusted to the desired size. 

 

 Preview Gallery  

Would you like to see all the previews for the loaded image or series? Open up 
the category “all” and then click on the symbol. 
 
Now COLOR projects 6 professional constructs a browser gallery with all the 
presets. For a larger display, move the scroll wheel of the mouse. If you want 
to apply a preset, simply click on the preview image. This way you can also 
create a preview view for each category. 

 
This very practical feature is reminiscent of good old contact sheets. You can 

create proofs to assess how the image with your favourite presets would look 

when printed. 

 The Variation Browser  
The variation browser allows you to choose from different versions of a func-
tion and is primarily operated with the mouse: 

 Shifting the segment: Hold down the left mouse button, before 
moving the mouse 

 Zooming in: Scroll up 

 Zooming out: Scroll down 

 Choosing the variant: Double left click on the image 
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 Setting a referent: Left click on the image 

 Comparison with referent: Hold down the right mouse button 
over the image 

 
The corresponding shortcuts can be found under„Menu Information  show 
shortcuts…“. 
 

Click on the symbol  and COLOR projects 6 professional will show you the 
entire preview gallery of that chosen category.  

 
Zoom in on the variant that you want to compare and set a reference image. 
 
You will be able to put this reference image on any image through a left click 
of the mouse. You can fade in this reference image into the other image by 
holding down the right mouse button. The border surrounding the image in a 
green dashed line shows you the reference image so that you can make the 
comparison. In this way you can compare any two variants in the browser 
directly and visually. 
 
Example: As a reference image you choose the variant “Natural Vivid Colours” 
and mark the image with a left mouse click. The green dashed line shows that 
you have chosen this image. 
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Now you look for a different preview image. In this case preset „Artistic Vin-
tage“ has been chosen.  

 
Here you can see the presets "Naturally Vivid Colours" and "Artistic Vintage" in direct 
comparison. 

 
Right click on the preset „Artistic Vintage” and the reference preset will fade 
in. As soon as you let go of the mouse button, you will see the „Artistic Vin-
tage” again. This is how you simply and purposefully compare looks with an-
other before choosing the ones you like the best. 

 
Selection of your desired variation:  
With a double click you chose the variant. The adjustment of the relevant 
program settings will be carried out automatically. 
 

Tip: Your current choice will, when you open the window, be automatical-
ly set as your reference image. 
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Deleting of a variation: 
If you want to delete a variation, move 
the cursor over it and click the [Del] button. After that, click on the “compress” 
button. If you want to display the deleted variations again click on “reset”.  

 

 Combine presets   
To merge two looks together use the “Combine default presets" button direct-

ly under the categories. These new presets will be saved under "Custom". It’s 

that easy to expand your numerous options and accumulate new ideas! 

 

 Import/Export of Presets  

Presets from earlier versions can be easily imported. Do you want to exchange 

all of your presets with a friend or just secure all of your treasures? Use the 

practical export function. 

 

 Filter Presets  

Locating presets can be difficult when you have imported presets or created 

many additional looks. For example, enter “filter" into the search bar and only 

presets relating to “filter” will be shown, for example “Gradient filter” or “Col-

ours Red filter”. This makes the search a lot easier. 

 

 Name Favourites    

Have you found presets that you particularly like and that you always want to 

have handy?  
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Click on the top right star in the preset window and add the setting to your 

favourites. By clicking the button, previews all of your favourite presets will be 

displayed. 

 

 

 Custom Presets 

One thing is certain, regardless of which 

settings you have changed, if you have 

applied additional filters or adjusted a 

filter’s settings, the selected preset has 

been modified and to the right of the 

preview image is the following symbol:   

Clicking  will reset the preset back to 

its initial state. Careful: All of the 

modifications applied up to this point will be undone! 

Clicking   saves all of the changes in a new preset. 

A dialog box will open where you can enter 

a new name for your preset or confirm the 

suggested one. The system will name it 

“Copy”.    
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The preset will be saved and moved 

to the “Custom" presets category. The 

new preset has been additionally 

generated and the starting preset is 

preserved. You can also never over-

write a default preset!  

Let’s switch now to the “Custom" 

preset category.   

Here we can find our first custom 

preset.   

There are a few new symbols to the 

right of the preview image: 

   

Is this the favourite preset that you 

have made? Mark it to find it right 

away next time!  

   

Have you changed this preset and 

don’t want to lose this new look? 

Then create a new one!   

   

Reset the most recently changed settings for the newest preset.  

   

You have readjusted once again? No problem. Save the changes with the disk 

symbol. 

  Change the preset’s name. 

 

  You can also delete your custom preset entirely.   
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  Use this to enter a search filter. 

For example, enter the search filter 

„venedig“, and subsequently type the 

term into the search filter bar directly 

under “Import". All presets with this 

search filter will be dis-played. 

You can enter the names of places 

you’ve holidayed and all of the presets 

that you used for those specific holiday 

photos will then be easy to find and to 

apply to other pictures.  

The filter drop down menu to the right already contains „venedig“ and you can 

simply select it from the entered search filters. 

 

 Save Undo-Point 

With the Save Undo-Point Function you can save your edits to an image at 

different intervals and later view these in the Timeline and pick up where 

you left off. 

 

  Timeline 

In the Timeline you can view and directly access all saved Undo-Points. 
 

 Panorama View  

Panorama View enables you to take an even closer look at your image by 
displaying it as a panorama image. 

 

 Comparison View  
Do you want a comparison to the original image? Simply right click on the 
middle of the image to see the before/after result. A quick check on the 
editing process is available at any time. For an extensive overview with 
selectable areas and luminance display, click on the symbol bar. 
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 Activates the left/ right comparison 

 Activates the above/ below comparison 

 Activates the upper left/ lower right comparison 

 Activates the lower right/ upper left comparison 

 Switches before and after in the comparison window 

 Activates or deactivates the luminance display 

 Switch between 3 different modes fort the luminance display: “two selec-
tive areas for shadows and light areas“, “from area 1 to area2“ and outside of 
area 1 and 2” 

 Switches between colour and black-and-white view in the comparison 
window 

 
 

Move the two luminance areas within the luminance bar from 0% (black) to 
100% (white). 
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You can also dock the comparison view onto the sidebars below “default set-
tings” or “finalise”. 
 

 Histogram   
The Histogram shows the distribution 
of tonal values within your image. The 
cumulative histogram shows how 
colour and luminance elements are 
distributed across the image. A flat 
cumulative histogram shows a brighter 
image; a bulge in the curve indicates a 
much darker image. You can receive a 
large display by clicking on the histo-
gram. A right click on the large display 
closes the histogram and the preview 
window appears.  
 

 Preview Mode  
If this option is activated your original image is displayed in a smaller version. If 
you switch it off, all calculations will be carried out in full-size images. Please 
note that deactivation takes more time to process in the preview mode. 
 

 Real Time Processing  
When activated, all of the changes that you have made to the preset settings 

will be immediately applied to the image and you will see the outcome of your 

adjustments directly. If this option is deactivated, then you will only see the 

outcome of your adjustments when you click the button “recalculate”:  

 
 

 High-Quality Display  
Activate this option to see the preview image in high-resolution. If the preview 

is set at 100%, there will be no difference. If you zoom in on a section of the 

photo however, there is a noticeable difference in quality.    
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 Border Pixel Display  
The border pixel display helps to reveal areas that tend towards maximal light 

and dark values that is to white and black. Dark border pixels are depicted by 

blue/purple and light pixels by red/orange/yellow.  

 

 
Depiction of border pixels in blue/purple and red/orange/yellow tones. 

 
If you like to brighten this image, you have to be careful of the orange border 

pixels. Light surfaces on the car and the walls should not become too white in 

order to avoid losing detail.  

In technical terms, these patches are called “burned highlights”. The border 

pixel view helps to find these critical image areas. 

 

 Symbol „Original Resolution Setting“  
Use this button to set the zoom factor to original resolution. 
 

  „Increase the Zoom factor to the screen size”  

With this symbol you will enlarge the zoom factor to the maximum possible 
screen size.  
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9. Post-Processing: Finalisation 

 

Now that we have understood the most important part of post-processing, 

let’s continue onto fine-tuning, which can be found on the right side of the 

screen under “Finalise". All these procedures are optional and can only be 

used if the images are to be further processed after a preset has been select-

ed. 

 

 The Magnifying Glass 

On the right-hand side (at the very top) in Post-processing you will find the 1:1 

magnifying glass. The magnifying glass shows you the area under the mouse in 

a 1:1 pixel view. 

 

To keep the magnifying glass on a specific point, press down on the “L“ key, 

while you move the mouse over the screen.  
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Click into the image area of the magnifying glass, to change between the dis-

play modus “divided before/after comparison” and “direct before/after com-

parison”. 

To free the fixated area of the magnifying glass, press down on the “L” key 

once more. 

 Point of Interest  

Activated “Point of Interest” renders the current editing only to a specially 

defined area of the image. The effects will be applied in their full form, howev-

er only visible in the specified spots, the rest of the image will be left unaffect-

ed. This effect is intended for very large, high-resolution photos, for example 

panorama pictures.    

 

  New: Intelligent Colour Space (SCA method)   

In this new drop-down menu, you make the decision for the optimal colour 
detail gradations of your image. The choice of the SCA (Smart Colourspace 
Adaption) method shows differences in the details of saturated colours. With 
increased calculation time, better detail structures are created in the colours.  
 
Tip: In Supersampling mode you 
get rich colours with unique col-
our details! 
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 Photo film emulation 
 

COLOR projects 6 professional has 

come up with a photofilm emulation 

engine that projects film-looks of the 

legendary days of analogue film onto 

your digital photos.  

After you have decided on an emula-

tion, the current motif and all presets 

are converted to an approximation of 

this photo film. 

In this version you will find 47 new 
fantastic photofilm emulations: 
 
Rummage through a box of old photos 

– it´s worth it! Select a type of film 

and its specific colour characteristics 

as well as the grain and contrast film 

effects, to apply to your picture. Since 

the grain of a photo is a very specific characteristic, one is able to adapt the 

strength of the grain via a controller. You can regulate the intensity of individ-

ual features as well as the overall effect of a film look.   

Tip: A double-click resets the photo film emulations to their default values. 

Alternatively, you can also click on these arrow keys:  

 

 Photofilm Browser  
Activate the photofilm browser and select a suitable photofilm by double-

clicking on the respective image. The photofilm browser works like the variant 

browser (see chapter 8). 
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 Calculate photofilm emulation first  
If this mode is active, the photofilm emulation will be calculated  on the source 

image before calculating the selected effects. 

 

 

 Optimisation Assistant  
 

The optimisation assistant is a very efficient tool for fast, fascinating results. 

When the preset is activated, denoising, tonal value, clarity, dynamic and 

sharpness settings can all be adjusted by sliding the control to the left or right. 

The result can be seen live. 

The optimisation assistant is intelligent; it remembers the values you’ve previ-

ously entered and applies the same settings to the next image in the same 

way, but adapting the result to the new motif. 
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 If you would like to edit without the 

assistant, you can simply turn it off. If 

you would like to turn off the values 

that have been “learned” so far, click 

on the button .  

Additionally, the assistant can be 

given optimising specifications for an 

entire image style: choose between 

„natural“, „naturally cool“, „naturally 

warm“, „soft“, „fine“, „brillant“, 

„intense“, „sober colours“, „colour-

ful“, „high-Key“, „low-Key“ and „low-

Key colourful“. The new methods are 

marked in red: 

 

 

 Optimisation Assistant Browser  
Select a suitable optimisation preset by double-clicking on an image. 

 

 The Opacity Regulator of the Optimisation Assistant 
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The opacity regulator in the optimisation assistant activates itself auto-

matically as soon as one optimisation is activated. The opacity regulator works 

on every effect that optimises the image as well as the optimising presettings. 

Pro Tip: Keep in mind that the presets and the optimisation assistant add up: If 

you select the Preset "Landscape Powerful" and the Preset "Intense", you will 

get highly saturated colours and large differences in contrast. That's no prob-

lem, you can quickly switch to "natural" optimization and restore the familiar 

look of the "Powerful Landscape" preset. On the other hand, you can switch 

back and forth between intensive, desaturated and high-key/low-key looks at 

lightning speed and thus collect new creative ideas.  

Tip: 

Set the optimisation presetting to “High-Key” and adjust the opacity slide 

control to a value between 40-60%. 

 

 Granulation module 
 

1. Natural Grain 

In natural grain the different levels of photographic paper are simulated, 

which creates a natural irregularity. These following parameters are 

therefore at your disposal: 

- Form 

Choose here from six different variants.  

 

 

- ISO-Number 
The preset value conforms to the average “restless value” on a naturally 
grey surface. 
 

- Size 
The maximum size of the simulated granulation. 
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- Masking 
Gives you the opportunity to calculate the granulation in all different 

types of daylight or alternatively in light, shade or shade and light. 

 

 
Complete: All brightness values receive natural film grain. 

 
Lights: The lights receive natural film grain. 

 
Shadow: The shadows receive natural film grain. 

 
Lights & Shadows: Both receive natural film grain. 

 

 
A Click on the button creates a new random distribution of grain and 

therefore a whole new look. 

 

2. Fractal Grain 

Fractal grain simulates a large scale 

irregularity, which is created through 

the storing and deterioration of photo 

material. 

Therefore the following parameters are 

at your disposal: 

 

 

- ISO-Number 

The preset value conforms to the average “restless value” of a naturally 

grey surface. 

 

- Quality 

Determines the accuracy of the calculation (number of iterations for the 

fractal algorithm) of the fractal granulation.  
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In the granulation module there is no singular best setting, since the ideal 

grain size, form and quality is 100% dependant on the motif. Here you can try 

out different things and find new creative paths. 

 
A Click on the button creates a new random distribution of grain and 

therefore a whole new look. 
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10. Local Adjustments/Selective Drawing 

 

The highlight tool from COLOR projects 6 professional deserves very special 

attention. Firstly, this tool selectively edits chosen areas without complicated 

masks done by hand, like other photo editing programs. COLOR projects 6 

professional includes a newly developed intelligent border recognition algo-

rithm that independently identifies borders, lines, differentiations and light 

differences in drawing mode. The boundaries of the area that the mouse has 

skimmed over are saved as a mask. These easily and precisely set masks serve 

as the basis for twelve important image enhancements: „Show original image“, 

“Correct red eye”, „Beauty“,  „Shading“, „Illuminating“, „Intensifying colour“, 

„Reduce colour“, „Strengthen details“, „Reduce details“, „Increase contrast“, 

„Reduce contrast“ and „Sharpen“. These masks can even be saved as a sepa-

rate image file and used in other photo editing programs. 

 

How it all works is probably easiest to explain with an example. Open the 

selective drawing window (post-processing, finalise - bottom right). Our exam-

ple is a single RAW file. The picture’s colour details are already well edited. 

Now we want to intensify the colours of the sky above the chair so that the 

scene doesn't look so sparse anymore. The chair, the sea and the beach should 

not change their colours. 
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1. Select editing objective 

For this case, select “Intensifying colour”. Make sure that the selected mask 

function is activated and the green checkmark is showing.    

 

2. Activate drawing mode    

3. Activate filling mode  
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4. Run the mouse over the contours without clicking. You can decide 
and correct the brush size afterwards. 

 

5. Now look at the mask display. The object where the borders were 
automatically recognised is now displayed in purple. Click and hold, 
and then trace your mouse along the edges of your chosen object 
until it is completely selected. In the blink of an eye we will see the 
effect as well as the overlying mask. 

 

6. Once fully selected, blend the mask out by moving the mask in-

tensity control to the left. 

   

7. You will now see only the effect that is coloured balloons – our ob-

jective was “Intensifying colour”. Now you can adjust the intensity of 

the effect by sliding the control towards the + or -, according to your 

preferred strength.  
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8. Done! The sky is more colourful while the chair, the sea and the 

beach are untouched by the change. 

9. Click on “Close”. You will be returned to post-processing and the se-
lective change will be applied. 

 

On the right you can clearly see a more colour intensive sky after the selec-

tive correction. The foreground and sea still have the same tonal values. 

 

10. Use your quickly made mask for a further effect. Go back to the se-

lective drawing. Our selective mask has remained. Click on  and 

copy the mask to the clipboard. Switch the mask to “Shading” and 

use the  to paste the mask back again. Now you have only dark-

ened the sky; other parts of the image were remain untouched. 

11. Every selectively applied effect can be activated and deactivated 

with the green checkmarks. 

12. Borders have different intensities in every image. Presets normally 

do just fine, but sometimes it is necessary to adjust the contour and 

sharpness settings in order to reach perfect fine-tuned results. 
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13. Have you drawn outside of the lines, despite the border recognition? 

You can easily fix it with the eraser . If you only want to remove a 

small section, use the eraser with limitation. When set to 50%, you 

can only remove 50% of the mask, regardless of how much you 

erase. The limited drawing mode works in the same way, and only 

draws at a certain opacity. 

14. If you want to mask the entire image except for a small object, it is a 

good idea to mask only the small object and then reverse the mask 

by clicking on the . 

 

Pro Tip: You have two filling modes to choose from when you want to fill a 

mask. When do you use which mask? We used the normal fill mode  as in 

our example for a large surface, which is also preferred for water and sky 

areas. 

Ray filling mode  is very precise and 

favoured for smaller objects, geometric 

forms or subjects with straight lines, like 

here in our example with the chair.  
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Ray filling mode allows you to mask the chair perfectly while keeping the sky and 

ground surfaces untouched. 

 

 Optional Mask Colours 

For the presentation of the mask as well as the brush, choose one of the 

ready-made colours. The display will be immediately adjusted to your desired 

colour. 

 

 

 Selective Drawing – Creating Masks 

Masks can also be created from a colour or brightness.  
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With the button (1) you activate the “Create Mask” modus. You will find your-

self in the standard mode “Create Mask out of Colour” (2). If you want to 

create the mask out of a brightness, choose the (3) button. 

The tolerance controller decides, how sharp (smaller value) or soft (higher 

value) the created mask will be. 

While in the “create mask” mode, your mouse pointer will turn into a pipette. 

The colour or brightness in which your mouse pointer is set, will determine the 

type of mask being created. 

 

In the above example, we can see how a red mask has been created for the 

sky. 

Tip: 

If you want to combine several colours in one mask, simply click on the desired 

colours after each other with the pipette on the screen. The current colour will 

with every click be added to the current mask. 

 

 Selective Drawing – Smoothing Brush 

The smoothing brush (1) gives you the opportunity to draw selective areas of 

the mask softly.  
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To draw an area even softer, just go over the same area with the smoothing 

brush several times. 

 Global Mask Functions 

In the area of global mask functions are several special modes that one can use 

directly.  

 

  



COLOR projects 6 professional – User manual 

 

56 

1. Reducing the entire mask outline 

 becomes  

 

2.  Increasing the entire mask outline 

 becomes  

 

3.  Soft-focus effect on the entire mask 

 becomes  

 

With global functions there are two buttons – the left button fulfils the func-
tion with a lower effect while the one on the right with a bigger effect.  
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 Reset the Function of a Mask 

Every mask can without any influence on the other masks be reset to its origi-

nal state. You simply click on the waste paper button (1). 

 

After clicking on the button a security query will follow, so that no important 

work can be lost by accident. 

 

 Adaption of automatic Masks onto the „Distortion correction“ of 

the RAW module 

Selective drawing works directly with the RAW module. This includes the “Dis-

tortion correction” that is part of the RAW module and that is applied com-

pletely automatically on several drawn masks. 

Here is an example where the sky has already been masked. 
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When we now subsequently correct in the RAW module the horizon within the 

image, then the drawn mask will automatically adjust itself to the “Distortion 

correction”. 
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11. Composing Mode 

 

In the Composing mode of selective 

drawing you have the opportunity to 

build up to 4 levels of images into your 

current motif. 

To switch into the composing modus, 

click on the “composing” button (1). 

From the list of choices (2) you can 

choose with which composing level you 

want to work with. 

With the button (3) you activate the 

currently chosen mask. Now you can 

through a click on the frame of the 

image (4) upload any image you wish 

to create the next level. 

You can use RAW images, Jpg, Tiff as 

well as several other image formats. 
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Underneath the display screen you will find the parameter area that begins 

with two buttons with the following functions:  

(5) Multiple Application 

Reduce the size of the image on a different level than the one that you´re 

currently working on. With this option you will be able to stretch the reduced 

image outwards (up, down, left, right).  

(6) Determine the Width-to-Height Ratio 

This function allows you to determine the width-to-height ratio of the upload-

ed levels, since the width-to-height ratio in an uploaded image level can differ-

entiate from the current image you´re working on. This preserves the propor-

tion of the levels.  

(7) Horizontal Reflection 

This function allows the image layer to be mirrored horizontally. This enables 

more precise adjustment to the current image without having to make chang-

es to the image layer.  

(8) Vertical Reflection 

This function allows the image layer to be mirrored vertically. This enables 

more precise adjustment of the current image without having to make chang-

es to the image layer.  

(9) The Control-Parameter 

Width-to-height ratio: If the width-to-height ratio isn´t fixed with the button 
(6), you will be able to change the width-to-height ratio however you desire. 
Zoom: Choose the size of that image level by zooming in or out. 
Shifting horizontally: Move the image level to the left or right. 
Shifting vertically: Move the image of that level up or down. 
Exposure to light: Exposure levels in your current image may not always match 
those of the image level. Here you can adapt the exposure and darken or 
brighten the images however you want until they match.  
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A night image with a not very fascinating night sky... 

 

.... can be transformed into an eyecatcher within one minute with the help of 
composing. 
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12. Texture Mode  

 

The new module in Selective Drawing from 

COLOR projects 6 professional gives you 

the possibility to add various textures and 

materials to your images.  Clicking on the 

symbol to the right will display the texture 

selection.  

Here you can find the 64 different textures 

you have at your disposal. These can be 

applied to your image on up to 16 different 

layers.  

Clicking on the Zoom Field will show all 64 

different textures at a glance and allow to 

choose between them. 

 

 

For this, simply click on your preferred texture and use the Selective Paint-

brush to apply it to your image.   



COLOR projects 6 professional – User manual 

 

63 

 

In the Menu at the right of your screen you are given the possibility to further 

adjust your chosen textures according to various parameters. The editing 

possibilities available here include options such as Brightness, Contrast, Zoom, 

Reflected Light, Image Structure, Distortion and Colour Variation.  

In addition to these, Selective Drawing also includes a module for creating 

your own textures using your own individual design. Here you can choose 

between four different automatic edge alignment procedures.  

 

To open the module, move the mouse over a texture until this plus symbol 

appears:  . This opens the additional functions. Click on , to load an 

image file and convert it to a square texture. To save a texture as an image file, 

click  . After you have decided on an edge adjustment, either a selection 
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for the adjustment of the structure size or for the adjustment of the brightness 

opens. 

 

 

Save mask: Click on  to save the current mask as an image file. 

Load image file as mask: Click on  to load an image file into the current 

mask. The resolution of the loaded image file is automatically adjusted to the 

resolution of the current mask. 

It is also possible to import or export textures from the texture database. Click 

on the corresponding button and choose between import and export of the 

textures.  

 

Note: By resetting the database, you can return to the supplied textures at any 

time. 
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Click on  to reset the texture database to the state of the installation. If 

you click on  a complete texture database is created from the textures 

you have loaded.  

 

 

 

Note: The textures you have not loaded are created by blending the surround-

ing textures around the respective texture. 
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Use the sliders on the left to adjust the textures. 

    



COLOR projects 6 professional – User manual 

 

67 

13. Removal of Scratch and Sensor Errors 

 

Modern photography unfortunately shows with high contrasts and many 

details every unwanted sensor contamination, which every photographer 

knows and fears despite camera-internal sensor cleaning. Don't worry - just 

remove it! With the easy to use correction function of COLOR projects 6 pro-

fessional this can even be really fun.  

Pro Tip: This intelligent correction doesn’t only remove sensor spots, but other 

disturbing things too - a deserted beach has never been so easy to produce.   

Simply mark defects in your motif, the program will automatically substitute 

these areas with other appropriate parts of the image.  

 

The sensor spots are circled in red.   
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Here’s how to go about correcting: 

Select the brush tool under (6) and click on the point of the image that you 

would like to correct. A circle will appear beside it that will serve as a source.   

Move this circle to a place on the 

image that can act as a source 

for the first marking. The select-

ed area will then be improved 

based on the source.  

Prior to this, you can reveal 

sensor spots, which will appear 

as a bright patch in the image, 

with (1).  

(2) Allows you to expose or hide 

the fixed areas. The corrections 

are still active, even if they have 

been blended in.  Hiding is solely 

to enable a before and after 

comparison. 

You can select multiple areas to correct by simply clicking on the brush symbol 

(6) and adding another point.   

The button marked (3) can blend the targeted corrections in and out, which 

also controls clarity.  

(5) Deletes the added corrections.   

The section marked (7) controls the size of the area that is to be corrected.   

You also have the option to automatically search for the best source area for 

the improvement. Click on the (8) button.  

Button (4) calculates the appropriate correction spots for all of the points 

automatically set using (8). 

All currently selected corrections can be deleted with the (9) button.  
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The sensor spot corrector marks all of the patches and determines a source within the 
image that can be used as a substitute. 
 

 
Successful sensor spot correction.  
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14. Post-Processing: Expert Mode 

 

The Post-Processing expert mode can be found on 

the right side of the screen. Here you can config-

ure all post-processing, try new effects, adjust a 

selected preset or construct a completely new 

preset to meet your desires.  

Overview of the Tools: 

a) Display finalisation assistant or opti-

misation assistant active/inactive  

b) Display natural grain/ fractal grain ac-

tive or reset 

c) Filter (from 181) 

d) Selected effects (resulting from the 

preset + your additionally selected 

post-processing effects) 

e) Parameters of the selected effects 

 

to a) display finalisation assistant 

Here, it is worth taking a look at whether 

one has made changes to the settings of the 

photo film engine, the optimisation assis-

tant, the spectral sensitivity, the grain mod-

ule or the colour toning. Thus, it is easy to 

find undesired effect duplications.  

 

to b) display natural grain/ fractal grain 
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Here you have an overview 

whether grain was added, with 

the option to reset the setting 

here. 

to c) filter (181)  

The post-processing effects list contains 181 different post-processing ef-

fects that can be applied in any combination.  

The effects are divided into six categories that are highlighted in colour:  

Yellow: Edge effects 

Green: Geometric effects 

Cyan: Exposure Effects 

Blue: Colour effects 

Violet: Blur effects 

Pink: Artistic Effects 

 

Tip: If you're looking for an effect and 

know the name or part of the name, 

you can make things easier by using 

the search box to find and display the 

effect. 

If you're applying new post-processing effects, check if the optimisation assis-

tant is active. If yes, please keep in mind that effects with the optimisation 

assistant work differently, sometimes much more extreme. Switch it off to 

create or extend a preset (button above post-processing Effects).  
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to d) selected effects 

 

Once you've found an effect you 

want to try, simply double-click 

it in the list of post-processing 

effects.  

Now the effect will be displayed 

in the block below - "Selected 

Effects".  

The block of selected filters is 

the core of the Post-Processing section. Here you can manage the entire image 

post-processing as well as the parameters of the individual effects.  

The filters in the example are automatically applied one after the other to the 

image and lead to the edited result image.  

- To temporarily deactivate an effect, simply click on the checkbox in 

front of the effect name and un-

check it. 

- Double-click an effect to remove it 

from the list. 

- To rearrange effects within the list 

as desired, you can move them up or 

down using drag & drop.  

Tip: The order of the effects within the list can 

have a significant influence on your result 

image. It's worth trying it out.  

Activate the 360-degree panorama mode in 

the box at the bottom left if you want to pre-

pare images for perfect panorama stitching. 

The effects are then optimized in such a way 

that no borders can appear when the individual images are joined together. 
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The list of selected effects contains a context menu with numerous functions 

that you can use to activate, deactivate, move or duplicate effects.  

New: Smart Mask Filters 

COLOR projects 6 professional calculates from top to bottom for the selected 

effects. This means that the order of the effects within the list can have a 

significant influence on your result image. For example, if you activate the 

"Mask Lights" effect, all subsequent effects will only affect the lights in your 

image. 

Below the display for selected effects there is also the "Copy result image to 

original" function. This sets the current event image as a new original image, 

as if you had loaded this event image. Use this function to save calculation 

time for many effects. 

 

 

to e) parameters of the selected effects 

Settings for the selected effects can be found directly below the block for the 

effects you have selected. The parameters for the currently selected effects 

will always be shown here.   

The available settings and options 

change depending on the effect you click 

on. There are sliders, gradation and 

mask curves, colours and pipettes etc. 

Alternatively, a numerical value can be 

entered into the box above the slider.  

The example shows the parameters for 

the “colour balance” effect, consisting of 

three controls for the balance: Cyan-Red, Magenta-Green and Yellow-Blue. By 

moving the slider, you make a change that is immediately displayed in the 

result image.  
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In addition, you will see a colour overflow inside the slider, giving you a direct 

indication of how the new value will affect the image.  

 

Image without adjustment of cyan-red and yellow-blue values.  

 

 

The adjustment of the cyan-red and yellow-blue values results in a signifi-

cantly warmer colour rendering of the image. 

 

 Example Mask Curves:  
This curve regulates the intensity of the effect for particular bright areas of the 

image.  When you pull a point downwards, pixels with this brightness will be 

impacted less by this specific effect, and vice versa.  

Here you will find in the top right hand-side a box with several different pre-

settings. In this example the pre-setting “bright lights” has been chosen. 
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For the gradation curve in this example, it means that the lights in the picture 

will be brightened, and the dark areas will exempted in order to create a strik-

ing contrast. This is how mask curves give you the opportunity to selectively 

influence images. 

 

Before/After Comparison 
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During the editing, the preview behind the mask curve immediately shows the 

effect’s intensity from black (no effect) to white (full effect).  

Another very effective way to set effect parameters is the real-time preview. 

 A "Play" button  is located to the left of each slider in the parameter area. If 

you click on this button, the value range of the corresponding value will run 

forward and backward one time. If you have found a setting that suits you, 

simply press the "ESC" key and the value will be accept-

ed immediately. 

 

 Layer Processing Methods 

These features determine the way that an applied 

effect appears on a layer. Effects can thus be enhanced 

or reduced, and looks can even be completely changed, 

which opens up a plethora of opportunities to play with. 

To apply processing methods, click on the drop down 

menu beginning with “Normal”.   

New methods are: Add, add limited, add difference, 

deep shadows, bright lights, 9 HSV methods and 9 HSL 

methods. 

Next to the drop-down menu you will find a percentage 

display that you can use to adjust the opacity. 

So that you don’t have to try out every single effect, we 

have a layer mode browser:    
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The application of different layer processing methods results in completely different 

results for a single effect. 

With just one click, you have an overview of all of the processing methods and 

can comfortably choose which method fits the effect best. Give it a try! The 

effects that you can generate with layer processing methods are astounding!   

 

 Selective Editing:     

For every single one of the 181 post-processing effects it is possible to apply 

the selected effect to only a certain area. 

Furthermore, specified areas of an image can be influenced at different inten-

sities by different effects.  

The selective editing can be controlled in the parameter area of each effect 

and you can open the accompanying window with the button at the far left.   

At the bottom of this window there are three blocks with six, three and two 

buttons.    
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The example clearly shows that the „colour intensity“ effect has only been applied to 
the selected section. Since the edge definition is only set to 93%, this area is almost 
rectangular. 

 
Adds a positive selective area. A positive selective area declares that 

the current effect should be applied to the selected area. 

 
Adds a negative selective area. A negative selective area declares that 

the current effect should NOT be applied to the selected area. 

 
Inverts the currently selected area.  

 
Creates a duplicate of the currently selected area. 

 
Deletes the currently selected area. 

 Inverts all selective areas.  

 
Deactivates the display of selective areas. 

 
Displays single selective areas. Selected effects will be stronger in 

bright areas.  

 
Displays all selective areas. Selected effects will be stronger in bright 

areas. 

 
Selects the next selective area. 
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Selects the previous selective area.  

 

6 Block: add, remove, duplicate, flip and delete the selected areas. 

3 Block: various display modes for the resulting intensity of the effect. 

2 Block: choice of selected surfaces, very practical if the specified areas are 

very small or overlapping. 

You can add up to 32 amplifying (positive) or reducing (negative) areas for the 

current effect. The size and position can be determined directly in the image, 

optionally in the corners or on the sides of the area.    

The roundness of the rectangle as well as the sharpness and severity of the 

selected area can be adjusted with the three controls at the top of the win-

dow.   

The result will always be instantly displayed upon releasing the mouse button. 

 

 Selective Editing – Gradient Module 

You can choose from every post-processing effect in the area of selective 

editing a course (gradient) of 56 premade models with a single click. 

To activate the desired post-processing effect from your chosen effects, click in 

the underlying parameter area on the gradient- slider. 

A window will open with different types of gradients. From there choose with 

a left click your desired type of gradient. 
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Note 1: The gradient templates that are selected are always applied to the 

currently selected effect. Thus the mask has a completely different effect if 

you set the same mask to "Sharpen Fine" or to "light tuning". 

 

Note 2: If you select a gradient template, the selective areas that may already 

exist in the currently selected effect are copied to the clipboard and can be 

retrieved using the Paste button. 

 

 Overview of important keyboard shortcuts: 

Cursor buttons: move the current, active, selected area 

Ctrl/Alt + Cursor: fast movement of the current, active, selected area 

1,2,3: switch the display mode 

Del: deletes the current, active, selected area 

ESC: closes the window 

Upon closing the window, the chosen effect will only be applied to the select-

ed area and displayed in the middle of the screen.   
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You can transfer other effects to the selected area with the “Copy” and 

“Paste” buttons  without having to retrace the selection again.   

 

This button deletes all selected areas of the active filter, of course 

with a confirmation prompt first. 
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15. Workflow 

 Edit final image further in an external program  
COLOR projects 6 professional offers interaction with external programs. After 

successfully completing your initial edits, this lets you continue to make fur-

ther changes in another image editing program of your choice.   

 

 Open in other projects programs 

 

Click on the “Projects” symbol in the toolbar to open the image in a different 

program from the projects series. Use the drop-down menu beside the symbol 

to choose one of the programs that you already have installed on your com-

puter. 

 

 Open in other photo-editing programs 

To directly open the image in another 

photo editing program (such as Adobe 

Photoshop), click on the corresponding 

button in the symbol bar.  

If necessary, go through the settings to 

show the path to the program. Click on 

“Extras” in the menu and select “Set-

tings” in the drop-down menu: 

Next, click on the “Export” tab. You can 

enter the name of a photo editing pro-

gram here and save it for later as well.    
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 Work with a Timeline and Restore Points 
This option can be found in the symbol bar at the top of the screen: 

 

“Create Restore Point” saves an in-between point of the current settings. You 

can now always return to this stage of your editing. You can save as many 

editing restore points as you like. The timeline displays the restore points and 

makes it possible to call up any phase with just a single click:   



COLOR projects 6 professional – User manual 

 

85 

 

This function is especially useful for testing the outcomes of additional effects 

and settings on your image. Simply set a restore point and carry on editing 

your picture. If you want to go back, simply click on your restore point  in 

the timeline. Click on  and you can add a note as a headline. 
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16. Selecting and Saving Sections of Images   

 
Save final images using the buttons in the toolbar, from the file menu or use 

the corresponding keyboard shortcut (Ctrl + S). 

 

 Cropping and Captions 

As soon as you have initiated a file save, the cropping and caption window will 

open. If you do not wish to crop or add a caption to your image, click on con-

tinue.  

 

At the top of your screen you will find several practical aids for perfect image 

composition and cropping.  

You can set the aspect ratio and activate guidelines like the rule of thirds, the 

golden section or the golden spiral.  Practical is also the new photo centre 

display that you can obtain by simply clicking on this button . 

The centre of the window shows your final image. Fix the area to be saved by 

adjusting the corners and borders of the photo.   
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At the bottom is an option to enter a caption. You can determine the size, 

position and background for the text. The size of the text will be automatically 

coordinated to the final cropping. 

 You can either crop free-hand or make use one of the 71 provided formats. 

Please note: If you choose the cropping ratio 13 x 18, for example, the final image will 

not be saved as 13 x 18 cm, rather as a ratio of 13 to 18.    

As soon as the image has been cropped and captioned, confirm the save and 

the following window will prompt you to select a file format and name your 

file.   
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17. RAW-Processing  

 

You can upload and edit RAW image data 

with the integrated RAW mode. Numer-

ous tools are available to you here, such 

as de-noising/sharpen, exposure, colour 

and detail as well as powerful distortion 

capabilities.    

Resetting the category 

Every category can through a click on the 

reset-button (bottom left) be reset to its 

original state without influencing the 

settings of the other categories. 

 

 

An overview of the most important RAW functions:   

White balance: Here you can regulate the colour temperature. Use the pipette 

to select a white balancing colour directly from the image.    

Denoising/ Sharpness: This feature regulates the image’s noise and sharpness. 

Control the quality and different types of noise such as colour noise, banding 

or hot pixels.   
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Colour balance/ white balance: Here it’s all about colour and black/white 

correction. Modify the general colour mood and neutralise white and black - 

the icing on the cake for professional colour correction.    

 

Exposure: Influence lights, shadows, contrast and brightness in the final image. 

With the new dynamic brightness, you can adapt the light to the contents of 

each image individually. 

Detail: Fine-tune clarity and micro-details with lights, shadows and mid-tones.   

The clarity regulates the overall strength of the local contrasts. The microde-

tails, i.e. the fine structures in the image data, can be adjusted from low to 

high. 

Colour: These colour settings are all about the luminosity of lights and shad-

ows. You can even reduce the presence of unwanted chromatic aberrations.    
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These light diffraction corrections 
allow you to purposefully remove the 
chromatic aberrations of a certain 
colour. Thereby a lens curve will be 
calculated backwards on top of the 
colour channel. You have the choice 
between: "light diffraction green", 
"light diffraction blue" and "light 
diffraction red". 
 
Palate: Adjust the saturation of indi-

vidual colours.   

Distortion: Take a closer look. These 

mighty tools can straighten out the 

horizon, correct camera angles and 

lens errors. Use “Autofit” to automat-

ically trim any awkward borders.   You 

can also use the two sliders at the top 

to fade in guides and adjust their size 

and visibility. By clicking on the rec-

tangle on the left, you can show guide 

lines. 

 

The reference grid can be adapted in 

the distance between the grids as well as in its transparency. This is how you 

will always have the maximum overview when you are correcting your set-

tings. 
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Peripheral light correction: Helps correcting the vignetting that might occur 

with some lenses.  

Lens correction: Corrects the curvature of the lens. 

Horizon: Rotates the image to correct the horizon. 

Vertical: Tilts the image to the left or to the right. 

Horizontal: Tilts the image to the front or the the rear. 

Zoom: Zoom into the image to avoid empty areas that might have been creat-

ed by the lens distortion correction.  

Trapezoid left/ right: With the vertical trapezoid distortion, the image can be 

distorted either at the left or right hand image border in order to adjust the 

perspective.  

Trapezoid top/ bottom: With the horizontal trapezoid distortion, the image 

can be distorted at the top or bottom image border in order to adjust the 

perspective. 

Stretch left/ right: With this stretch feature the image can be extended hori-

zontally starting either from the left or right image border.  

Stretch top/ bottom: With this stretch feature the image can be extended 

horizontally, starting either from the top or bottom image border. 

Aspect: Change the aspect ratio of your image data.  

Shift left/ right: Shift your image data to the left or to the right. 

Shift top/ bottom: Shift your image data up or down. 

 

FX: 

This category includes a several new special effects like a mist & fog correc-

tion, save highlights, sepia and film grains as well as different gradients. 

Pro Tip: 
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When you take a landscape shot, 

shift the controller to “Gradient 

top” to a dark tone to create a 

neutral thick (ND) – process filter. 

General: Activate the “360° 

panorama mode” to optimise 

matching edges of images in a 

panorama series. Save your 

settings as a camera profile to 

save time in the future. This can 

be reset at any time.    

If you have conducted the set-

tings in RAW mode, click on 

“apply”. 

 

 

 

 

 

 

If you save your settings in the camera profile, you will save a lot of time for 

future photographs. The settings can be reversed at any time.  
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New: Individual Camera Profiles 

You also have the possibility to create your own individual camera profile. 

Therefore, click on  . Individual camera profiles can be given their own 

name and contain all the same functions as profiles created automatically. If 

you would like to delete or rename your camera profile, click on the profile 

from within the dropdown options list with the right mouse button. 

 

 

Zoom and Brightness 

At the top right you will find the slide controls Zoom and Brightness for the 

Image Display. 

Note: With the Brightness of Image Display slide control you are only adjusting 

the brightness of the program display screen and not that of the image itself. 

This allows you to see the effect of a noise reduction in dark areas, for exam-

ple. 
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Histogram 

The histogram can be found underneath the slide controls.  

RGB: Display of image RGB values at your cursor’s location within the image. 

HSL: Display of image HSL values at your cursor’s location within the image. 

Note: HSL stands for Hue, Saturation and Lightness. 
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18. Batch Processing 

 COLOR projects 6 professional 

batch processing allows for auto-

matic processing of multiple 

bracketing series. The function 

can be found in the drop-down 

menu for Extras in the menu bar 

or by clicking the corresponding 

symbol on the start screen. 

First, choose the source folder 

where the individual images 

and/or the bracketing series are 

located. These data can also be 

mixed, because the automatic 

exposure series recognition sorts 

them for you. 

The “Include all subdirectories” checkbox not only searches through all of the 

selected folders, but also all subfolders and their further subfolders.   

Note: Remember that looking through folders with several subfolders can 

require a lot of time. That’s why selecting “C:\“ is not recommended. 

 

 Target directory: Here you determine where the result images of the 

batch processing are to be saved. Simply select the appropriate fold-

er using the "Select destination folder (. . .)" button or enter the des-

tination folder directly into the text field. 

 Format: You can choose from five formats for the storage format of 

the result images from batch processing. With .jpg and .tif two 8-bit 

formats and two 16-bit formats as well as one PNG format are avail-

able. JPG images are always stored in the highest possible quality 

and TIF files are uncompressed and lossless. 
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 Processing settings: Here you define the filters with which the batch 

is to be processed: From here you can once again access the image 

preparation and select the preset with which the images are to be 

developed. You can also activate automatic image optimisation. If 

you later want to montage the processed images into a 360-degree 

panorama, select the panorama mode here, which eliminates expo-

sure and contrast edges in the individual images. The presets contain 

all presets from the Post Processing area. It also contains all the pre-

sets you created yourself in the "(custom)" category. So you can cre-
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ate a special preset before batch processing and then apply it to 

multiple bracketing series. 

 

 

Tip: Rather choose a preset from the "Natural" or "Landscape" category if you 

want to develop a large number of images in one go. Extreme effects are 

better applied to single images. 

Click on the arrow  , to reset the batch processing settings to default 

values.   
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19. Via GPS coordinates directly to Open-StreetMaps 

If the GPS coordinates are in your Exif-files (Menu  Exif information), then 

you will be able to locate the place where the photo was shot when you click 

on the button “Open GPS coordinates via Browser”. You will see the place the 

photo was shot in www.OpenStreetMaps.org. 

 

 

 

 

 

 

  

http://www.openstreetmaps.org/
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20. Plug-in Installation 

COLOR projects 6 professional can also be used as a plug-in for Adobe® Pho-

toshop. Newer versions of Photoshop are automatically detected by COLOR 

projects 6 professional during installation and the plug-ins are installed in the 

respective plug-in folder. Older versions of Photoshop might require manual 

installation. 

 

 Installation in Adobe Photoshop & Photoshop Elements 

The following window will appear when installing COLOR projects 6 profes-

sional:  

 

Select the version of Photoshop where you would like to install the COLOR 

projects 6 professional plug-in. Click on “next” and follow the instructions 

from the installation assistant. The plug-ins will then be automatically in-

stalled.   
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You can also install the plug-ins at a later point in time. Please install 

Photoshop first, then the projects plug-ins! 

After installing the plug-ins please open Photoshop again. 

In Photoshop you will find the entry Franzis under the menu item "Filter". All 

plug-ins of the projects series are listed here.  

 

 

Click on COLOR projects 6 professional. The image opened and edited in Pho-

toshop is opened in COLOR projects 6 professional. 
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Now you will find the program in Photoshop Filter-Plugin mode. You will be 

able to edit the image as you´re used to in COLOR projects 6 professional.  

When you´re finished editing the image you can send the image directly back 

to Photoshop by clicking on the button “apply”. 

 

With the button “cancel” you finish the filter Plug-in, without sending the 

changes that you have done to the image back to the Photoshop level. The 

editing that you have done in COLOR projects 6 professional will be discarded. 

The project program will then automatically close itself. This mechanism is 

conducted by Adobe Photoshop and cannot be stopped. 

 

 Using Plug-ins with Mac OS X 

 

Adobe Photoshop & Adobe Photoshop Elements 

Plug-ins can be found on the start screen in the “Plug-ins” folder. Select the 

appropriate folder for your version of Photoshop (we chose Photoshop CS6 for 

our example). Double click the .zip file to extract the plug-ins.  

Next, drag & drop the plug-in COLORProjectsFilter_PH6.plugin (PH7 with 

other Photoshop versions) to the plug-in folder for your version of Photoshop, 

which is normally labelled as “plug-ins”: 

 

Start up your version of Photoshop, load an image and navigate to  
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„Menu Filter  Franzis COLOR projects 6 professional “ 

 

With a click you start the Plug-In. The image will now be opened in COLOR 

projects 6 professional. 

Now you will find the program in Photoshop Filter-Plugin mode. You will be 

able to edit the image as you´re used to in COLOR projects 6 professional. 
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When you´re finished editing the image you can send the image directly back 

to Photoshop by clicking on the button “apply”. 

 

With the button “cancel” you finish the filter Plug-in, without sending the 

changes that you have done to the image back to the Photoshop level. The 

editing that you have done in COLOR projects 6 professional will be discarded. 

The project program will then automatically close itself. This mechanism is 

conducted by Adobe Photoshop and cannot be stopped. 



COLOR projects 6 professional – User manual 

 

104 

 Using Adobe Lightroom Plug-ins - Windows 

 

 

 

Start the installation program and check in the component selection if “Light-

room Plugin” has been chosen. Copy the plug-in folder “Lightroom Plug-in” 

from your CD-ROM.   

Subsequently open your Lightroom version. Start Lightroom and navigate to 

“File Plug-in manager” to check if the plug-in has been activated. 
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LR: COLOR projects 6 professional: Installed and executed. 

 

Mark a bracketing series in your lightroom library. 
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Right-click on the image directly in Lightroom and select „Export  Export to 

COLOR projects 6 professional “. 

Or: Choose File  Export with Preset  Export to COLOR projects 6 profes-

sional “. 
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Using Adobe Lightroom Plug-ins - MAC OS X 

The Plug-In for Adobe Lightroom will not be automatically installed with MAC 

OS X. To integrate it into Lightroom, continue as follows:  

Install COLOR projects 6 professional to the program link of your Mac. 

Copy the plug-in .zip file from the “Lightroom Plug-in” folder on your CD-ROM. 

This was "packed" in a zip for safety's sake. Double click on the .zip file to 

extract the plug-in to a folder where you want it to be located.  

We recommend the folder where also your presets are stored:  

 „Users/Username/COLOR projects 6 professional “. 

 

Start Lightroom und navigate to “File  Plug-in Manager“.  

 

Click the “Add” button in the Lightroom Plug-In Manager.  
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Choose the relevant Lightroom-Plug-in of COLOR projects 6 professional that 

you have just copied to your computer, by navigating towards it. 

If the Plug-in is not instantly marked with a green active dot, close Lightroom 

and start it again.  

Now the Plug-In should be installed and be up and running.  

You have now several options to get your image from Lightroom to an COLOR 

projects 6 professional:  

„File  Export with Preset  Export to COLOR projects 6 professional “. 

OR: 

Right-click on the image directly in Lightroom and select „Export  Export to 

COLOR projects 6 professional“. 
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21. Keyboard Shortcuts 

 

Overview of the integrated Keyboard shortcuts 

An overview of keyboard shortcuts can be found in the main menu in the 

Information section. 

 

Click on this item to open the overwiew: 

 

In the overview you will be able to scroll through the different areas where 

shortcuts are available. 

To have constant access to the keyboard shortcuts via a separate window, you 

can use the function „open in browser“ (window bottom left), which will show 

the list in a standard browser. You will also be able to 

print the keyboard shortcuts from there.  
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General Functions: 

Windows Apple 

Ctrl N  cmd N New Project 

Ctrl O cmd O Load Single Image 

Ctrl S  cmd S  Save Final Image 

Ctrl D  cmd D  Print Final Image 

Ctrl C cmd C Insert Final Image into Clipboard 

Shift Z  Shift Z  Create Undo Point 

Ctrl T  cmd T  Open Timeline 

Ctrl F4 cmd F4 Exit Programme 

F4 F4 Open RAW Module 

F7 F7 Switch to Post Processing 

Ctrl P  cmd P  Open Setting 

Ctrl B Ctrl B Open Batch Processing 

@ @ Open Homepage 

Shift F1 Shift F1 Open About Dialogue 

Ctrl E cmd E Display Exif Information 

Ctrl H  cmd H Display/ Hide Histogram 

Ctrl F  cmd F Display Full Image 

 

Image Display Functions: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd - Zoom out 

Ctrl 0 cmd 0 Adapt to Screen 

Ctrl 1 cmd 1 100% View 

R  R Real-time mode on/off 

L  L Lock Radar Window 

 

RAW Development: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd + Zoom out 
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History Browser: 

Windows Apple 

Page up  Page up Previous Page 

Page down  Page down Next Page 

Home  Home  To Start 

End End To End 

Cursor left  Cursor left  Previous Entry 

Cursor right  Cursor right  Next Entry 

 

Variation Browser: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd - Zoom out 

Cursor left Cursor left Move View to the Left 

Cursor right Cursor right Move View to the Right 

Cursor up Cursor up Move View Up 

Cursor down Cursor down Move View Down 

Ctrl 0 cmd 0 Display All 

Space Space Move View around Centre 

S S Select Entry 

Del Del Delete Entry 

X X Compress View 

Home Home Reset View 

 

Sensitive Selective Drawing: 

Windows  Apple 

Ctrl +  cmd + Zoom in 

Ctrl -  cmd -  Zoom out 

Ctrl O cmd O 100% View/ Switch Fitting 

A  A Activate Brush 

Shift A  Shift A  Activate Limited Brush 

S S Activate Erasing Brush 

Shift S  Shift S  Activate Limited Erasing Brush 

W W Activate Soft-Focus Brush 
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E  E Activate Mark Creation from the Image 

D  D Activate Filling Mode 

F  F Activate Filling Mode for the Brush 

R  R Activate Ray Mode for the Brush 

1 1 Reduce Brush Size 

2 2 Increase Brush Size 

3 3 Reduce Opacity 

4 4 Increase Opacity 

5 5 Softer Contour Recognition 

6 6 Sharper Contour Recognition 

7 7 Reduce Softness 

8 8 Increase Softness 

Ctrl Z  cmd Z Previous Step 

M, Shift M  M, Shift M  Mask Display on/off 

 

Scratch & Sensor Error Correction: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd - Zoom out 

Cursor left, Shift Cursor left, Ctrl Move Active Correction Area to the Left 

Cursor left 

Cursor right, Shift Cursor right,  Move Active Correction Area to the Right 

Ctrl Cursor right 

Cursor up, Shift Cursor up, Ctrl  Move Active Correction Area Up 

Cursor up  

Cursor down, Shift Cursor down,  Move Active Correction Area Down 

Ctrl Cursor down  

Page up Page up Select Previous Correction Area 

Page down Page down Select Next Correction Area 

C  C Activate all Correction Areas 

N  N Set New Correction Area 

Del  Del Delete Active Correction Area 

+ + Increase Active Correction Area 
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- - Reduce Aktive Correction Area 

 

Selective Processing:  

Cursor left, Shift Cursor left, Ctrl Move selective area to the left  

Cursor left 

Cursor right, Shift Cursor right, Ctrl Move selective area to the right  

Cursor right 

Cursor up, Shift Cursor up, Ctrl Move selective area up 

Cursor up 

Cursor down, Shift Cursor down, Ctrl Move selective area down 

Cursor down 

Page up Page up Select previous selective area 

Page down Page down Select next selective area 

Del Del Delete active selective area 

1 1 Do not display mask 

2 2 Display mask of the active selective area 

3 3 Display mask of all selective areas 

 

Picture Cropping: 

Cursor left, Shift Cursor left, Ctrl   Move Cropping Area to the Left 

Cursor left 

Cursor right, Shift Cursor right,   Move Cropping Area to the Right 

Ctrl Cursor right  

Cursor up, Shift Cursor up, Ctrl   Move Cropping Area Upwards 

Cursor up  

Cursor down, Shift Cursor down,   Move Cropping Area Downwards 

Ctrl Cursor down    
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22. Integrated List of supported RAW Formats 

 

Located in the main menu under Information is an integrated list of supported 

camera RAW-formats sorted by manufacturer. 

 

Selecting this menu option will open the Camera RAW Formats Window. 

 

At the top of the window you will find a drop-down selection for filtering the 

list according to camera manufacturer. This way you will find your camera 

faster.  

To have constant access to the supporting camera RAW-formats via a separate 

window, you can use the function „open in browser“ (window bottom left), 

which will show the list in a standard browser. You will also be able to print the 

supporting RAW-formats from there.  
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Hotline/Support 

Contact the FRANZIS Customer Service Team for questions about installation, problems or disrup-

tions concerning this software product.  

E-Mail: support@franzis.de  

 

Telephone (Monday - Friday 12-18:00): +49 (0)180 30 02 644  

(0,09 EUR per Minute from German Landlines, mobile rates may vary) 

 

Telefax: 0180 300 26 45 (0,09 EUR per Minute from German Landlines, mobile rates may 

vary) 

 

Please bear in mind that your inquiries can only be handled by the FRANZIS Customer Service 

Support Team. This is how we can continue to make lasting improvements in our service quality while 

answering your questions quickly and professionally.  

Customer Service quick and easy: 

Have important information concerning your PC system and product ready: 

 Product Name 

 Product-ISBN-Number (These can be found on the back side of the product packaging 

located above the bar code). 

 Operating System of your PC 

 Information about your PC’s Configuration 

 

Copyright 

Franzis Verlag GmbH has prepared this product with the greatest possible care. Please read the following conditions: 
All the programs, routines, controls, etc., contained in this data media or within this download are protected by their 
respective authors or distributors as mentioned in the respective programs. The purchaser of this data media or of 
this download is authorised to use those programs, data or data groups that are not marked as shareware or public 
domain for his/her own purposes within the provisions of their designated use. He/she is authorised to use programs 
or parts of programs that are marked as shareware, freeware or public domain within the restrictions given by the 
respective programs or parts of programs. A reproduction of programs with the intent of distributing data media 
containing programs is forbidden. Franzis Verlag GmbH holds the copyright for the selection, arrangement and 
disposition of the programs and data on these data media or these downloads. 
The data and the programs in this data media or within this download have been checked with the greatest possible 
care. Considering the large quantity of data and programs, Franzis assumes no warranty for the correctness of the 
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